
Application: gvSIG desktop - Issues
# Tracker Status Priority Subject Assignee Updated# Tracker Status Priority Subject Assignee Updated

5764 gvSIG bugs Closed Normal Pestaña Webmaps no debería aparecer Francisco Díaz Carsí 10/06/2023 03:56 PM

5764 gvSIG bugs Closed Normal Pestaña Webmaps no debería aparecer Francisco Díaz Carsí 10/06/2023 03:56 PM

5652 gvSIG bugs Closed Normal Cuando se crea capa nueva su CRS siempre es 4326 aunque la Vista esté en otro Joaquín  del Cerro Murciano 08/03/2023 02:18 PM

5652 gvSIG bugs Closed Normal Cuando se crea capa nueva su CRS siempre es 4326 aunque la Vista esté en otro Joaquín  del Cerro Murciano 08/03/2023 02:18 PM

5639 gvSIG bugs Closed High Al aplicar Pan zoom se va el encuadre a una zona externa a la que se estaba Francisco Díaz Carsí 05/19/2021 11:39 AM

5639 gvSIG bugs Closed High Al aplicar Pan zoom se va el encuadre a una zona externa a la que se estaba Francisco Díaz Carsí 05/19/2021 11:39 AM

5478 gvSIG bugs Closed Urgent Al exportar a SHP salta error y no añade la capa resultante Francisco Díaz Carsí 10/18/2023 11:09 AM

5478 gvSIG bugs Closed Urgent Al exportar a SHP salta error y no añade la capa resultante Francisco Díaz Carsí 10/18/2023 11:09 AM

5419 gvSIG bugs Closed High Error al exportar capa con elementos seleccionados Francisco Díaz Carsí 09/30/2020 02:09 PM

5419 gvSIG bugs Closed High Error al exportar capa con elementos seleccionados Francisco Díaz Carsí 09/30/2020 02:09 PM

5405 gvSIG bugs Closed Normal Exportar a imagen solo genera el .rmf 09/28/2020 12:29 PM

5405 gvSIG bugs Closed Normal Exportar a imagen solo genera el .rmf 09/28/2020 12:29 PM

5382 gvSIG bugs Closed Normal La escala de la Vista no se actualiza cuando nos vamos alejando o acercando sobre ella Francisco Díaz Carsí 10/18/2023 11:09 AM

5382 gvSIG bugs Closed Normal La escala de la Vista no se actualiza cuando nos vamos alejando o acercando sobre ella Francisco Díaz Carsí 10/18/2023 11:09 AM

5330 gvSIG bugs Closed Normal Error al cargar ficheros gpap de proyectos de gvSIG Mobile 10/05/2020 09:28 AM

5330 gvSIG bugs Closed Normal Error al cargar ficheros gpap de proyectos de gvSIG Mobile 10/05/2020 09:28 AM

5324 gvSIG bugs Closed Normal Error al exportar a DXF Francisco Díaz Carsí 09/30/2020 02:33 PM

5324 gvSIG bugs Closed Normal Error al exportar a DXF Francisco Díaz Carsí 09/30/2020 02:33 PM

5284 gvSIG bugs Closed Normal Los rectángulos en la herramienta de dibujo rápido no funcionan correctamente 10/18/2023 02:12 PM

5284 gvSIG bugs Closed Normal Los rectángulos en la herramienta de dibujo rápido no funcionan correctamente 10/18/2023 02:12 PM

5240 gvSIG bugs Closed Urgent Da error al exportar a KML Óscar Martínez 06/12/2020 09:35 PM

5240 gvSIG bugs Closed Urgent Da error al exportar a KML Óscar Martínez 06/12/2020 09:35 PM

5230 gvSIG bugs Closed Normal Exportar capa: no aplica el filtro por expresión 04/26/2020 09:06 PM

5230 gvSIG bugs Closed Normal Exportar capa: no aplica el filtro por expresión 04/26/2020 09:06 PM

5200 gvSIG bugs Closed Urgent Al exportar a GML en la 2.5 salta error Óscar Martínez 06/19/2020 02:05 PM

5200 gvSIG bugs Closed Urgent Al exportar a GML en la 2.5 salta error Óscar Martínez 06/19/2020 02:05 PM

5194 gvSIG bugs Closed Normal Datos en Excel. Los carga pero no los visualiza Joaquín  del Cerro Murciano 03/26/2020 11:00 AM

5194 gvSIG bugs Closed Normal Datos en Excel. Los carga pero no los visualiza Joaquín  del Cerro Murciano 03/26/2020 11:00 AM

5191 gvSIG bugs Closed Immediate En la exportación a SHP no corrige los nombres de campos duplicados Óscar Martínez 04/10/2020 12:26 PM

5191 gvSIG bugs Closed Immediate En la exportación a SHP no corrige los nombres de campos duplicados Óscar Martínez 04/10/2020 12:26 PM

5178 gvSIG bugs Closed High La exportación de DXF/DWG a SHP no se hace correctamente Óscar Martínez 04/14/2020 08:36 PM

5178 gvSIG bugs Closed High La exportación de DXF/DWG a SHP no se hace correctamente Óscar Martínez 04/14/2020 08:36 PM

5126 gvSIG bugs Closed Normal Limpiar selección no se activa en documento Vista 11/04/2019 01:26 PM

5126 gvSIG bugs Closed Normal Limpiar selección no se activa en documento Vista 11/04/2019 01:26 PM

5115 gvSIG bugs Closed Immediate Mejorar usabilidad al Exportar capa 10/25/2019 11:01 AM

5115 gvSIG bugs Closed Immediate Mejorar usabilidad al Exportar capa 10/25/2019 11:01 AM

5113 gvSIG bugs Closed Normal Menú "Herramientas" aparece el segundo, entre "Archivo" y "Capa" Joaquín  del Cerro Murciano 10/22/2019 05:43 PM

5113 gvSIG bugs Closed Normal Menú "Herramientas" aparece el segundo, entre "Archivo" y "Capa" Joaquín  del Cerro Murciano 10/22/2019 05:43 PM

5079 gvSIG bugs Closed Normal No funciona el CRS cuando se hace exportación no simplificada de un SHP 04/30/2020 06:53 PM

5079 gvSIG bugs Closed Normal No funciona el CRS cuando se hace exportación no simplificada de un SHP 04/30/2020 06:53 PM

5053 gvSIG bugs Closed Normal En el "Tabbed ToC", en "Lista por fuente" no aparecen las capas remotas 10/22/2019 05:53 PM

5053 gvSIG bugs Closed Normal En el "Tabbed ToC", en "Lista por fuente" no aparecen las capas remotas 10/22/2019 05:53 PM

5035 gvSIG bugs Closed Normal Cierra el programa al aceptar cookies (hiperenlace a web con navegador interno) 10/18/2019 10:13 AM

5035 gvSIG bugs Closed Normal Cierra el programa al aceptar cookies (hiperenlace a web con navegador interno) 10/18/2019 10:13 AM

5033 gvSIG feature requests Closed Normal Nueva ventana de selección de atributos al exportar capa 03/04/2020 03:11 PM

5033 gvSIG feature requests Closed Normal Nueva ventana de selección de atributos al exportar capa 03/04/2020 03:11 PM

4998 gvSIG bugs Closed Normal No se refresca el localizador al añadir capas desde el TOC 04/01/2019 11:47 AM

4998 gvSIG bugs Closed Normal No se refresca el localizador al añadir capas desde el TOC 04/01/2019 11:47 AM

4997 gvSIG bugs Closed Normal Falta la opción de exportar a KML 04/01/2019 11:48 AM

4997 gvSIG bugs Closed Normal Falta la opción de exportar a KML 04/01/2019 11:48 AM

4975 gvSIG bugs Closed Normal Report by point no funciona Óscar Martínez 02/18/2019 05:28 PM

4975 gvSIG bugs Closed Normal Report by point no funciona Óscar Martínez 02/18/2019 05:28 PM

4964 gvSIG bugs Closed Urgent CRS are not correct at "Export to" tool / Los CRS no son correctos en la herramienta de "Exportar a" 03/05/2019 11:44 AM

4964 gvSIG bugs Closed Urgent CRS are not correct at "Export to" tool / Los CRS no son correctos en la herramienta de "Exportar a" 03/05/2019 11:44 AM

4961 gvSIG bugs Closed Low Error when saving a project with Pie or Bar chart legend / Error salvando proyecto con leyenda de 
tartas o barras

Francisco Díaz Carsí 05/09/2020 04:01 PM

4961 gvSIG bugs Closed Low Error when saving a project with Pie or Bar chart legend / Error salvando proyecto con leyenda de 
tartas o barras

Francisco Díaz Carsí 05/09/2020 04:01 PM

4927 gvSIG feature requests Closed Normal [PG] Informe de selección por punto Óscar Martínez 02/18/2019 05:02 PM

4927 gvSIG feature requests Closed Normal [PG] Informe de selección por punto Óscar Martínez 02/18/2019 05:02 PM

4855 gvSIG bugs Closed Normal Error when exporting to KML 10/17/2019 03:04 PM

4855 gvSIG bugs Closed Normal Error when exporting to KML 10/17/2019 03:04 PM

4749 gvSIG bugs Closed Normal The locator is broken Joaquín  del Cerro Murciano 01/03/2018 12:14 PM

4749 gvSIG bugs Closed Normal The locator is broken Joaquín  del Cerro Murciano 01/03/2018 12:14 PM

4744 gvSIG feature requests Closed Normal Geometry type by default when creating a new layer Joaquín  del Cerro Murciano 12/04/2017 09:58 AM

4744 gvSIG feature requests Closed Normal Geometry type by default when creating a new layer Joaquín  del Cerro Murciano 12/04/2017 09:58 AM

4730 gvSIG bugs Closed Normal Priorizar nuevo zoom sobre otra acción Joaquín  del Cerro Murciano 12/04/2017 10:04 AM

4730 gvSIG bugs Closed Normal Priorizar nuevo zoom sobre otra acción Joaquín  del Cerro Murciano 12/04/2017 10:04 AM

4717 gvSIG bugs Closed Normal zoom in asumes no drag / zum adentro asume que no hay arrastre del raton 10/18/2023 01:59 PM

4717 gvSIG bugs Closed Normal zoom in asumes no drag / zum adentro asume que no hay arrastre del raton 10/18/2023 01:59 PM

4698 gvSIG bugs Closed Urgent New shp layer: geometry types missing Joaquín  del Cerro Murciano 10/14/2017 08:33 PM

4698 gvSIG bugs Closed Urgent New shp layer: geometry types missing Joaquín  del Cerro Murciano 10/14/2017 08:33 PM

4692 gvSIG bugs Closed Normal Aplicar leyenda a localizador 03/04/2020 12:32 PM

4692 gvSIG bugs Closed Normal Aplicar leyenda a localizador 03/04/2020 12:32 PM

4620 gvSIG bugs Closed Normal Can't load a CSV layer from Add layer 09/06/2017 01:08 PM

4620 gvSIG bugs Closed Normal Can't load a CSV layer from Add layer 09/06/2017 01:08 PM

4574 gvSIG bugs Closed Normal "Select by layer" tool doesn't work 02/04/2019 04:35 PM

4574 gvSIG bugs Closed Normal "Select by layer" tool doesn't work 02/04/2019 04:35 PM

4562 gvSIG bugs Closed Normal Error when exporting a CSV file (as layer) to SHP 09/11/2017 12:16 PM

4562 gvSIG bugs Closed Normal Error when exporting a CSV file (as layer) to SHP 09/11/2017 12:16 PM

4545 gvSIG bugs Closed Normal The view scale denominator is not always refreshed when scrolling the mouse wheel 04/20/2020 11:26 AM

4545 gvSIG bugs Closed Normal The view scale denominator is not always refreshed when scrolling the mouse wheel 04/20/2020 11:26 AM

4509 gvSIG bugs Closed High Double-click doesn't work good on a layer at the TOC Francisco Díaz Carsí 06/23/2017 02:54 PM
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4509 gvSIG bugs Closed High Double-click doesn't work good on a layer at the TOC Francisco Díaz Carsí 06/23/2017 02:54 PM

4475 gvSIG bugs Closed Normal Google Street View no lanza el navegador del sistema 06/11/2017 09:53 PM

4475 gvSIG bugs Closed Normal Google Street View no lanza el navegador del sistema 06/11/2017 09:53 PM

4472 gvSIG bugs Closed Normal Añadir capa. Nueva opción de tileado Joaquín  del Cerro Murciano 06/19/2017 10:44 AM

4472 gvSIG bugs Closed Normal Añadir capa. Nueva opción de tileado Joaquín  del Cerro Murciano 06/19/2017 10:44 AM

4471 gvSIG bugs Closed Normal No  persiste ubicación de última capa añadida a la Vista Joaquín  del Cerro Murciano 06/15/2017 02:54 PM

4471 gvSIG bugs Closed Normal No  persiste ubicación de última capa añadida a la Vista Joaquín  del Cerro Murciano 06/15/2017 02:54 PM

4438 gvSIG bugs Closed High Access to the folders doesn't work in some computers with Windows Joaquín  del Cerro Murciano 06/11/2017 09:46 PM

4438 gvSIG bugs Closed High Access to the folders doesn't work in some computers with Windows Joaquín  del Cerro Murciano 06/11/2017 09:46 PM

4432 gvSIG feature requests Closed Normal "New layout" option at the Layout menu from the View 06/12/2017 02:23 PM

4432 gvSIG feature requests Closed Normal "New layout" option at the Layout menu from the View 06/12/2017 02:23 PM

4422 gvSIG bugs Closed Normal Right click on an active layer in the TOC should not deactivate other layers Francisco Díaz Carsí 06/11/2017 09:46 PM

4422 gvSIG bugs Closed Normal Right click on an active layer in the TOC should not deactivate other layers Francisco Díaz Carsí 06/11/2017 09:46 PM

4329 gvSIG bugs Closed Urgent Falla la carga de capas BING Daniel Martinez 08/27/2016 10:40 AM

4329 gvSIG bugs Closed Urgent Falla la carga de capas BING Daniel Martinez 08/27/2016 10:40 AM

4328 gvSIG bugs Closed Urgent Google Street View muestra imagen incorrecta Daniel Martinez 08/31/2016 11:42 AM

4328 gvSIG bugs Closed Urgent Google Street View muestra imagen incorrecta Daniel Martinez 08/31/2016 11:42 AM

4310 gvSIG bugs Closed Normal Google Street View no funciona en versión portable de Linux Joaquín  del Cerro Murciano 09/11/2017 11:46 AM

4310 gvSIG bugs Closed Normal Google Street View no funciona en versión portable de Linux Joaquín  del Cerro Murciano 09/11/2017 11:46 AM

4304 gvSIG bugs Closed Normal Export To doesn't export with the default user defined projection Francisco Díaz Carsí 08/04/2016 07:07 PM

4304 gvSIG bugs Closed Normal Export To doesn't export with the default user defined projection Francisco Díaz Carsí 08/04/2016 07:07 PM

4295 gvSIG bugs Closed Urgent Info by point is broken Francisco Díaz Carsí 08/04/2016 06:56 PM

4295 gvSIG bugs Closed Urgent Info by point is broken Francisco Díaz Carsí 08/04/2016 06:56 PM

4223 gvSIG bugs Closed Normal El pintado de capas no se cancela al ejecutar otro pintado 08/04/2023 11:48 AM

4223 gvSIG bugs Closed Normal El pintado de capas no se cancela al ejecutar otro pintado 08/04/2023 11:48 AM

4214 gvSIG bugs Closed Normal Dates at the "Select by attribute" tool don't work 07/25/2016 11:43 AM

4214 gvSIG bugs Closed Normal Dates at the "Select by attribute" tool don't work 07/25/2016 11:43 AM

4156 gvSIG bugs Closed Normal Exception reading shapefile 06/22/2016 12:43 PM

4156 gvSIG bugs Closed Normal Exception reading shapefile 06/22/2016 12:43 PM

4119 gvSIG bugs Closed Normal The locator is zoomable 09/06/2017 12:37 PM

4119 gvSIG bugs Closed Normal The locator is zoomable 09/06/2017 12:37 PM

4022 gvSIG bugs Closed Normal Layer name disappears in the ToC 01/20/2016 10:43 AM

4022 gvSIG bugs Closed Normal Layer name disappears in the ToC 01/20/2016 10:43 AM

4019 gvSIG bugs Closed Normal Select by polyline selects features only with minimum three vertices 02/06/2019 06:01 PM

4019 gvSIG bugs Closed Normal Select by polyline selects features only with minimum three vertices 02/06/2019 06:01 PM

3988 gvSIG bugs Closed Normal Info by point tool doesn't work Francisco Díaz Carsí 01/20/2016 10:35 AM

3988 gvSIG bugs Closed Normal Info by point tool doesn't work Francisco Díaz Carsí 01/20/2016 10:35 AM

3959 gvSIG bugs Closed Normal DBF files using UTF-8 encoding are incorrectly written 03/04/2020 12:40 PM

3959 gvSIG bugs Closed Normal DBF files using UTF-8 encoding are incorrectly written 03/04/2020 12:40 PM

3809 gvSIG bugs Closed Urgent No carga KML ni GML Daniel Martinez 12/21/2015 12:44 PM

3809 gvSIG bugs Closed Urgent No carga KML ni GML Daniel Martinez 12/21/2015 12:44 PM

3808 gvSIG bugs Closed Urgent Proyectos con datos CAD Joaquín  del Cerro Murciano 11/02/2015 01:54 PM

3808 gvSIG bugs Closed Urgent Proyectos con datos CAD Joaquín  del Cerro Murciano 11/02/2015 01:54 PM

3793 gvSIG bugs Closed High Text box of the Scale at the View doesn't show the complete number when it's higher to 999.999 Daniel Martinez 07/25/2016 10:45 AM

3793 gvSIG bugs Closed High Text box of the Scale at the View doesn't show the complete number when it's higher to 999.999 Daniel Martinez 07/25/2016 10:45 AM

3778 gvSIG bugs Closed Normal Problemas al cargar fichero GML 03/04/2020 02:40 PM

3778 gvSIG bugs Closed Normal Problemas al cargar fichero GML 03/04/2020 02:40 PM

3646 gvSIG bugs Closed Normal "Select by buffer" tool is not enabled on Views in Geographical coordinates 10/15/2015 11:42 AM

3646 gvSIG bugs Closed Normal "Select by buffer" tool is not enabled on Views in Geographical coordinates 10/15/2015 11:42 AM

3618 gvSIG bugs Closed Normal Nomenclator: Geonames no funciona Daniel Martinez 11/05/2015 11:07 AM

3618 gvSIG bugs Closed Normal Nomenclator: Geonames no funciona Daniel Martinez 11/05/2015 11:07 AM

3587 gvSIG bugs Closed Normal Failed to add elements to graphicsLayer, if this is already editing. Joaquín  del Cerro Murciano 10/15/2015 10:45 AM

3587 gvSIG bugs Closed Normal Failed to add elements to graphicsLayer, if this is already editing. Joaquín  del Cerro Murciano 10/15/2015 10:45 AM

3455 gvSIG bugs Closed Normal The General tab in the View properties is not the first one Francisco Díaz Carsí 05/19/2015 08:14 PM

3455 gvSIG bugs Closed Normal The General tab in the View properties is not the first one Francisco Díaz Carsí 05/19/2015 08:14 PM

3445 gvSIG bugs Closed Normal Locate by attribute tool should not be visible with an empty view 03/04/2020 12:42 PM

3445 gvSIG bugs Closed Normal Locate by attribute tool should not be visible with an empty view 03/04/2020 12:42 PM

3432 gvSIG bugs Closed Normal ApplicationLocator.getManager().getActiveComponent() junto con EditingExtension pueden crear 
bucles infinitos

Francisco Díaz Carsí 05/07/2015 05:50 PM

3432 gvSIG bugs Closed Normal ApplicationLocator.getManager().getActiveComponent() junto con EditingExtension pueden crear 
bucles infinitos

Francisco Díaz Carsí 05/07/2015 05:50 PM

3389 gvSIG bugs Closed High "Select by polyline" tool works as "Select by polygon" 02/06/2019 06:03 PM

3389 gvSIG bugs Closed High "Select by polyline" tool works as "Select by polygon" 02/06/2019 06:03 PM

3307 gvSIG bugs Closed Normal problems to select multipart features / problemas para seleccionar registros de partes múultiples 04/16/2020 04:19 PM

3307 gvSIG bugs Closed Normal problems to select multipart features / problemas para seleccionar registros de partes múultiples 04/16/2020 04:19 PM

3194 gvSIG bugs Closed Normal "Select all" button is active after pressing on it, but the active tool is different José Badía 04/07/2015 12:03 PM

3194 gvSIG bugs Closed Normal "Select all" button is active after pressing on it, but the active tool is different José Badía 04/07/2015 12:03 PM

3166 gvSIG bugs Closed Normal InfoByPoint: RuntimeException when vector and raster layers are active 08/04/2023 11:56 AM

3166 gvSIG bugs Closed Normal InfoByPoint: RuntimeException when vector and raster layers are active 08/04/2023 11:56 AM

3144 gvSIG bugs Closed Normal "View > Navigation > Zoom into (out from) center" don't work fine 03/04/2015 10:53 AM

3144 gvSIG bugs Closed Normal "View > Navigation > Zoom into (out from) center" don't work fine 03/04/2015 10:53 AM

3135 gvSIG bugs Closed Normal "Zoom out from the center" tool doesn't work 01/26/2015 09:42 AM

3135 gvSIG bugs Closed Normal "Zoom out from the center" tool doesn't work 01/26/2015 09:42 AM

3132 gvSIG bugs Closed Normal Falla la exportacion a dxf de un shape 3d. 06/15/2015 10:24 AM

3132 gvSIG bugs Closed Normal Falla la exportacion a dxf de un shape 3d. 06/15/2015 10:24 AM

3127 gvSIG bugs Closed Normal Clicking on the mouse scroll the active tool is executed Joaquín  del Cerro Murciano 01/26/2015 09:42 AM

3127 gvSIG bugs Closed Normal Clicking on the mouse scroll the active tool is executed Joaquín  del Cerro Murciano 01/26/2015 09:42 AM

3110 gvSIG bugs Closed Normal Mal funcionamiento del Behavior del attribute editor Francisco Díaz Carsí 01/20/2015 07:57 PM

3110 gvSIG bugs Closed Normal Mal funcionamiento del Behavior del attribute editor Francisco Díaz Carsí 01/20/2015 07:57 PM

3090 gvSIG bugs Closed Normal "Add field" button in the "New layer" wizard cuts its text José Badía 04/07/2015 12:15 PM

3090 gvSIG bugs Closed Normal "Add field" button in the "New layer" wizard cuts its text José Badía 04/07/2015 12:15 PM

3083 gvSIG bugs Closed Normal "Intersection_point" i18n conflict 12/29/2014 01:20 PM

3083 gvSIG bugs Closed Normal "Intersection_point" i18n conflict 12/29/2014 01:20 PM

3042 gvSIG bugs Closed Normal Missing translations in Derived geometries Lluís Marqués 02/02/2015 01:13 PM

3042 gvSIG bugs Closed Normal Missing translations in Derived geometries Lluís Marqués 02/02/2015 01:13 PM

3010 gvSIG bugs Closed Normal Cut and paste of groups of layers doesn't work fine José Badía 04/07/2015 12:18 PM
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3010 gvSIG bugs Closed Normal Cut and paste of groups of layers doesn't work fine José Badía 04/07/2015 12:18 PM

3007 gvSIG bugs Closed Normal Error al exportar de dgn a shp Francisco Díaz Carsí 05/20/2015 09:32 AM

3007 gvSIG bugs Closed Normal Error al exportar de dgn a shp Francisco Díaz Carsí 05/20/2015 09:32 AM

3005 gvSIG bugs Closed Normal Locator by attribute field combo doesn't show all the possible values Daniel Martinez 11/05/2015 11:29 AM

3005 gvSIG bugs Closed Normal Locator by attribute field combo doesn't show all the possible values Daniel Martinez 11/05/2015 11:29 AM

2977 gvSIG bugs Closed Normal Error al exportar una capa de eventos a shp con elementos seleccionados Francisco Díaz Carsí 04/21/2015 02:28 PM

2977 gvSIG bugs Closed Normal Error al exportar una capa de eventos a shp con elementos seleccionados Francisco Díaz Carsí 04/21/2015 02:28 PM

2969 gvSIG bugs Closed Normal Dyschromatopsia tooltip is not translatable José Badía 01/20/2015 05:42 PM

2969 gvSIG bugs Closed Normal Dyschromatopsia tooltip is not translatable José Badía 01/20/2015 05:42 PM

2922 gvSIG bugs Closed Normal Comportamiento de capas agrupadas en el TOC José Badía 05/07/2015 06:31 PM

2922 gvSIG bugs Closed Normal Comportamiento de capas agrupadas en el TOC José Badía 05/07/2015 06:31 PM

2856 gvSIG bugs Closed High Can't create a new shape layer 10/14/2014 09:48 AM

2856 gvSIG bugs Closed High Can't create a new shape layer 10/14/2014 09:48 AM

2835 gvSIG bugs Closed High Shp file is not loaded when loading with other one Joaquín  del Cerro Murciano 02/02/2015 01:10 PM

2835 gvSIG bugs Closed High Shp file is not loaded when loading with other one Joaquín  del Cerro Murciano 02/02/2015 01:10 PM

2718 gvSIG bugs Closed Normal Añadir al conjunto crea un conjunto nuevo en "Selección por capa" José Badía 04/07/2015 12:28 PM

2718 gvSIG bugs Closed Normal Añadir al conjunto crea un conjunto nuevo en "Selección por capa" José Badía 04/07/2015 12:28 PM

2714 gvSIG bugs Closed Normal Dyschromatopsia plugin creates a new "Vista" menu José Badía 01/20/2015 05:41 PM

2714 gvSIG bugs Closed Normal Dyschromatopsia plugin creates a new "Vista" menu José Badía 01/20/2015 05:41 PM

2708 gvSIG bugs Closed Urgent Info by point error Joaquín  del Cerro Murciano 07/28/2014 06:42 AM

2708 gvSIG bugs Closed Urgent Info by point error Joaquín  del Cerro Murciano 07/28/2014 06:42 AM

2561 gvSIG bugs Closed Normal "Symbology" tab in the properties of the layer is now at the end José Badía 04/07/2015 12:34 PM

2561 gvSIG bugs Closed Normal "Symbology" tab in the properties of the layer is now at the end José Badía 04/07/2015 12:34 PM

2534 gvSIG bugs Closed Low Annotation progressbar runs forever José Badía 05/19/2015 08:11 PM

2534 gvSIG bugs Closed Low Annotation progressbar runs forever José Badía 05/19/2015 08:11 PM

2533 gvSIG bugs Closed Normal Issues in the New layer wizard 04/20/2020 11:37 AM

2533 gvSIG bugs Closed Normal Issues in the New layer wizard 04/20/2020 11:37 AM

2483 gvSIG bugs Closed High Selección por capa no funciona 06/13/2014 01:49 PM

2483 gvSIG bugs Closed High Selección por capa no funciona 06/13/2014 01:49 PM

2481 gvSIG bugs Closed Normal Selecciona elementos en leyendas 06/06/2014 01:56 PM

2481 gvSIG bugs Closed Normal Selecciona elementos en leyendas 06/06/2014 01:56 PM

2479 gvSIG bugs Closed Normal Areas y distancias desactivado sin datos vectoriales Joaquín  del Cerro Murciano 11/24/2014 08:33 AM

2479 gvSIG bugs Closed Normal Areas y distancias desactivado sin datos vectoriales Joaquín  del Cerro Murciano 11/24/2014 08:33 AM

2478 gvSIG bugs Closed Normal Centrar vista a punto: warning 06/06/2014 02:29 PM

2478 gvSIG bugs Closed Normal Centrar vista a punto: warning 06/06/2014 02:29 PM

2448 gvSIG bugs Closed Normal Selection by polyline in the view is missing Miguel Company 04/07/2015 12:40 PM

2448 gvSIG bugs Closed Normal Selection by polyline in the view is missing Miguel Company 04/07/2015 12:40 PM

2425 gvSIG bugs Closed High GML Catastro no se visualiza o carga de forma incorrecta Juan Lucas Domínguez 03/09/2014 11:37 PM

2425 gvSIG bugs Closed High GML Catastro no se visualiza o carga de forma incorrecta Juan Lucas Domínguez 03/09/2014 11:37 PM

2404 gvSIG bugs Closed Normal Error in the cursor when the "Info by point" window is closed Ignacio Brodín 03/10/2014 12:20 PM

2404 gvSIG bugs Closed Normal Error in the cursor when the "Info by point" window is closed Ignacio Brodín 03/10/2014 12:20 PM

2402 gvSIG bugs Closed Normal Rotation and height values are not correct when exporting to Annotation layer Ignacio Brodín 03/28/2014 01:19 PM

2402 gvSIG bugs Closed Normal Rotation and height values are not correct when exporting to Annotation layer Ignacio Brodín 03/28/2014 01:19 PM

2390 gvSIG bugs Closed High Reprojected vector layers are not shown at certain scales Juan Lucas Domínguez 03/28/2014 12:02 PM

2390 gvSIG bugs Closed High Reprojected vector layers are not shown at certain scales Juan Lucas Domínguez 03/28/2014 12:02 PM

2353 gvSIG bugs Closed High Hiperenlace disponible cuando no está activado Ignacio Brodín 03/09/2014 11:41 PM

2353 gvSIG bugs Closed High Hiperenlace disponible cuando no está activado Ignacio Brodín 03/09/2014 11:41 PM

2350 gvSIG bugs Closed High Capa eventos, CSV no permite visualizarlo Juan Lucas Domínguez 03/10/2014 12:22 PM

2350 gvSIG bugs Closed High Capa eventos, CSV no permite visualizarlo Juan Lucas Domínguez 03/10/2014 12:22 PM

2347 gvSIG feature requests Closed Normal Añadir capa de eventos (a Vista) por defecto Ignacio Brodín 03/10/2014 12:22 PM

2347 gvSIG feature requests Closed Normal Añadir capa de eventos (a Vista) por defecto Ignacio Brodín 03/10/2014 12:22 PM

2343 gvSIG bugs Closed Low View resizes after adding layers Joaquín  del Cerro Murciano 10/15/2015 10:39 AM

2343 gvSIG bugs Closed Low View resizes after adding layers Joaquín  del Cerro Murciano 10/15/2015 10:39 AM

2342 gvSIG bugs Closed Normal Deseleccionar elementos con Ctrl no funciona Ignacio Brodín 03/09/2014 11:41 PM

2342 gvSIG bugs Closed Normal Deseleccionar elementos con Ctrl no funciona Ignacio Brodín 03/09/2014 11:41 PM

2341 gvSIG bugs Closed Normal No se centra correctamente la Vista sobre un punto Juan Lucas Domínguez 03/10/2014 12:26 PM

2341 gvSIG bugs Closed Normal No se centra correctamente la Vista sobre un punto Juan Lucas Domínguez 03/10/2014 12:26 PM

2318 gvSIG bugs Closed Low No refresca al exportar selección de capa 06/17/2014 10:48 AM

2318 gvSIG bugs Closed Low No refresca al exportar selección de capa 06/17/2014 10:48 AM

2289 gvSIG bugs Closed Normal WMS. La leyenda se corta en su mar Ignacio Brodín 03/10/2014 12:06 PM

2289 gvSIG bugs Closed Normal WMS. La leyenda se corta en su mar Ignacio Brodín 03/10/2014 12:06 PM

2258 gvSIG bugs Closed Low Selección por círculo en capa de eventos 04/29/2015 12:40 PM

2258 gvSIG bugs Closed Low Selección por círculo en capa de eventos 04/29/2015 12:40 PM

2253 gvSIG bugs Closed Normal El plugin de HyperLink no presenta correctamente los documentos de tipo texto Juan Lucas Domínguez 03/10/2014 10:33 AM

2253 gvSIG bugs Closed Normal El plugin de HyperLink no presenta correctamente los documentos de tipo texto Juan Lucas Domínguez 03/10/2014 10:33 AM

2244 gvSIG bugs Closed Urgent Añadir localizador: no se pudieron añadir paneles Juan Lucas Domínguez 02/01/2014 01:26 PM

2244 gvSIG bugs Closed Urgent Añadir localizador: no se pudieron añadir paneles Juan Lucas Domínguez 02/01/2014 01:26 PM

2243 gvSIG bugs Closed Normal Error al pulsar botón derecho sobre agrupación Juan Lucas Domínguez 02/01/2014 01:31 PM

2243 gvSIG bugs Closed Normal Error al pulsar botón derecho sobre agrupación Juan Lucas Domínguez 02/01/2014 01:31 PM

2162 gvSIG bugs Closed Normal NPE when mouse move on a view with degrees units Juan Lucas Domínguez 01/27/2014 05:30 PM

2162 gvSIG bugs Closed Normal NPE when mouse move on a view with degrees units Juan Lucas Domínguez 01/27/2014 05:30 PM

2131 gvSIG bugs Closed Normal Mouse wheel zooms in/out too much sometimes Juan Lucas Domínguez 01/27/2014 05:30 PM

2131 gvSIG bugs Closed Normal Mouse wheel zooms in/out too much sometimes Juan Lucas Domínguez 01/27/2014 05:30 PM

2113 gvSIG bugs Closed Normal Export to WMC: option to use the view's extent keeps disabled forever Ignacio Brodín 02/20/2014 11:32 PM

2113 gvSIG bugs Closed Normal Export to WMC: option to use the view's extent keeps disabled forever Ignacio Brodín 02/20/2014 11:32 PM

2002 gvSIG feature requests Closed Normal Allowing user to choose how to decide position of added layers Juan Lucas Domínguez 01/27/2014 05:31 PM

2002 gvSIG feature requests Closed Normal Allowing user to choose how to decide position of added layers Juan Lucas Domínguez 01/27/2014 05:31 PM

1986 gvSIG feature requests Closed Normal Select by buffer tool button should be desabled if no features are selected Juan Lucas Domínguez 01/27/2014 05:32 PM

1986 gvSIG feature requests Closed Normal Select by buffer tool button should be desabled if no features are selected Juan Lucas Domínguez 01/27/2014 05:32 PM

1985 gvSIG bugs Closed Normal Select by buffer tool: lack of refresh in the view Juan Lucas Domínguez 01/27/2014 05:38 PM

1985 gvSIG bugs Closed Normal Select by buffer tool: lack of refresh in the view Juan Lucas Domínguez 01/27/2014 05:38 PM

1984 gvSIG bugs Closed Normal Select by buffer tool: wrong width input format Juan Lucas Domínguez 01/27/2014 05:38 PM

1984 gvSIG bugs Closed Normal Select by buffer tool: wrong width input format Juan Lucas Domínguez 01/27/2014 05:38 PM

1983 gvSIG bugs Closed Normal Grouping raster layers doesn't work properly 01/13/2014 12:36 PM

1983 gvSIG bugs Closed Normal Grouping raster layers doesn't work properly 01/13/2014 12:36 PM

1982 gvSIG bugs Closed Normal When copying a group of layers, layers are copyed twice Juan Lucas Domínguez 01/27/2014 05:51 PM
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1982 gvSIG bugs Closed Normal When copying a group of layers, layers are copyed twice Juan Lucas Domínguez 01/27/2014 05:51 PM

1981 gvSIG bugs Closed Normal Enconding error when opening a shapefile 01/28/2014 08:54 AM

1981 gvSIG bugs Closed Normal Enconding error when opening a shapefile 01/28/2014 08:54 AM

1957 gvSIG feature requests Closed Normal Add support to "open folder" hyperlink type 04/29/2015 12:01 PM

1957 gvSIG feature requests Closed Normal Add support to "open folder" hyperlink type 04/29/2015 12:01 PM

1953 gvSIG bugs Closed Normal Hyperlink to html: page visualization is wrong Joaquín  del Cerro Murciano 06/14/2017 05:09 PM

1953 gvSIG bugs Closed Normal Hyperlink to html: page visualization is wrong Joaquín  del Cerro Murciano 06/14/2017 05:09 PM

1941 gvSIG feature requests Closed Normal Adding event theme: Add toolbar button and more intuitive menu option Juan Lucas Domínguez 01/27/2014 05:48 PM

1941 gvSIG feature requests Closed Normal Adding event theme: Add toolbar button and more intuitive menu option Juan Lucas Domínguez 01/27/2014 05:48 PM

1930 gvSIG bugs Closed Normal Locator doesn't refresh until the mouse pointer goes over it Juan Lucas Domínguez 01/28/2014 11:16 AM

1930 gvSIG bugs Closed Normal Locator doesn't refresh until the mouse pointer goes over it Juan Lucas Domínguez 01/28/2014 11:16 AM

1928 gvSIG feature requests Closed Normal Send a layer to the background 09/06/2023 12:52 PM

1928 gvSIG feature requests Closed Normal Send a layer to the background 09/06/2023 12:52 PM

1893 gvSIG bugs Closed High Filter ">=" operator doesn't work as expected 01/28/2014 08:55 AM

1893 gvSIG bugs Closed High Filter ">=" operator doesn't work as expected 01/28/2014 08:55 AM

1861 gvSIG bugs Closed Urgent Error loading a shapefile Ignacio Brodín 01/28/2014 08:55 AM

1861 gvSIG bugs Closed Urgent Error loading a shapefile Ignacio Brodín 01/28/2014 08:55 AM

1828 gvSIG bugs Closed Normal Layer set to... options should be in the View menu instead of in the Layer menu Juan Lucas Domínguez 01/28/2014 08:56 AM

1828 gvSIG bugs Closed Normal Layer set to... options should be in the View menu instead of in the Layer menu Juan Lucas Domínguez 01/28/2014 08:56 AM

1827 gvSIG bugs Closed Normal View locator: edit style tool opens a dialog that can't be used until we close the locator setup dialog Juan Lucas Domínguez 01/28/2014 11:16 AM

1827 gvSIG bugs Closed Normal View locator: edit style tool opens a dialog that can't be used until we close the locator setup dialog Juan Lucas Domínguez 01/28/2014 11:16 AM

1826 gvSIG bugs Closed Normal View locator: layer doesn't appear in the list after adding it Juan Lucas Domínguez 01/28/2014 11:17 AM

1826 gvSIG bugs Closed Normal View locator: layer doesn't appear in the list after adding it Juan Lucas Domínguez 01/28/2014 11:17 AM

1825 gvSIG bugs Closed High InfoByPoint tool edit controls doesn't work. 01/13/2014 10:04 AM

1825 gvSIG bugs Closed High InfoByPoint tool edit controls doesn't work. 01/13/2014 10:04 AM

1824 gvSIG bugs Closed High Edit controls in InfoByPoint tool should not be shown when the layer is not in editing mode 01/28/2014 08:59 AM

1824 gvSIG bugs Closed High Edit controls in InfoByPoint tool should not be shown when the layer is not in editing mode 01/28/2014 08:59 AM

1794 gvSIG bugs Closed High InfoByPoint NullPointerException using spinner 01/28/2014 09:00 AM

1794 gvSIG bugs Closed High InfoByPoint NullPointerException using spinner 01/28/2014 09:00 AM

1787 gvSIG bugs Closed Normal Remove a layer in a group Juan Lucas Domínguez 01/28/2014 09:01 AM

1787 gvSIG bugs Closed Normal Remove a layer in a group Juan Lucas Domínguez 01/28/2014 09:01 AM

1786 gvSIG bugs Closed Urgent Raster layers are not visible if they are inside groups in the TOC Ignacio Brodín 01/28/2014 09:02 AM

1786 gvSIG bugs Closed Urgent Raster layers are not visible if they are inside groups in the TOC Ignacio Brodín 01/28/2014 09:02 AM

1699 gvSIG bugs Closed Normal Se lanza herramienta "localizar por atributo" sin seleccionarla Juan Lucas Domínguez 01/28/2014 09:03 AM

1699 gvSIG bugs Closed Normal Se lanza herramienta "localizar por atributo" sin seleccionarla Juan Lucas Domínguez 01/28/2014 09:03 AM

1691 gvSIG bugs Closed Normal Opciones habilitadas y no aplicables en menú Juan Lucas Domínguez 02/01/2014 01:32 PM

1691 gvSIG bugs Closed Normal Opciones habilitadas y no aplicables en menú Juan Lucas Domínguez 02/01/2014 01:32 PM

1540 gvSIG bugs Closed Normal After ungrouping, view is not refreshed after changes in layers (visibility, etc) Juan Lucas Domínguez 02/26/2014 12:34 PM

1540 gvSIG bugs Closed Normal After ungrouping, view is not refreshed after changes in layers (visibility, etc) Juan Lucas Domínguez 02/26/2014 12:34 PM

1496 gvSIG bugs Closed Normal Error message after move a minimized view Juan Lucas Domínguez 01/28/2014 09:10 AM

1496 gvSIG bugs Closed Normal Error message after move a minimized view Juan Lucas Domínguez 01/28/2014 09:10 AM

1457 gvSIG bugs Closed Normal Pestaña WFS en Propiedades de capa (shp) Juan Lucas Domínguez 01/28/2014 09:10 AM

1457 gvSIG bugs Closed Normal Pestaña WFS en Propiedades de capa (shp) Juan Lucas Domínguez 01/28/2014 09:10 AM

1427 gvSIG feature requests Closed High View windows does not adapt to the project window Joaquín  del Cerro Murciano 10/15/2015 10:41 AM

1427 gvSIG feature requests Closed High View windows does not adapt to the project window Joaquín  del Cerro Murciano 10/15/2015 10:41 AM

1372 gvSIG feature requests Closed Normal Press and hold  the middle mouse button (scroll wheel)  to activate the Pan Tool 03/25/2015 11:40 AM

1372 gvSIG feature requests Closed Normal Press and hold  the middle mouse button (scroll wheel)  to activate the Pan Tool 03/25/2015 11:40 AM

1348 gvSIG bugs Closed Normal Does not shown 'Text' in dwg layers Francisco Díaz Carsí 05/29/2015 09:59 AM

1348 gvSIG bugs Closed Normal Does not shown 'Text' in dwg layers Francisco Díaz Carsí 05/29/2015 09:59 AM

1346 gvSIG bugs Closed High Can't cut a layer Juan Lucas Domínguez 11/06/2012 01:10 PM

1346 gvSIG bugs Closed High Can't cut a layer Juan Lucas Domínguez 11/06/2012 01:10 PM

1345 gvSIG bugs Closed High Can't copy a layer Juan Lucas Domínguez 11/06/2012 01:11 PM

1345 gvSIG bugs Closed High Can't copy a layer Juan Lucas Domínguez 11/06/2012 01:11 PM

1341 gvSIG bugs Closed High 'Remove edges' checkbox from Enhance tab of Properties of a raster doesn't persist Ignacio Brodín 02/26/2014 12:34 PM

1341 gvSIG bugs Closed High 'Remove edges' checkbox from Enhance tab of Properties of a raster doesn't persist Ignacio Brodín 02/26/2014 12:34 PM

1329 gvSIG bugs Closed High Does not assign the metadata CRS to the layer (gml, kml and dxf) after add them to the view Juan Lucas Domínguez 11/06/2012 02:23 PM

1329 gvSIG bugs Closed High Does not assign the metadata CRS to the layer (gml, kml and dxf) after add them to the view Juan Lucas Domínguez 11/06/2012 02:23 PM

1320 gvSIG bugs Closed Immediate click on symbology not working / click sobre simbología no acciona Juan Lucas Domínguez 11/06/2012 02:06 PM

1320 gvSIG bugs Closed Immediate click on symbology not working / click sobre simbología no acciona Juan Lucas Domínguez 11/06/2012 02:06 PM

1319 gvSIG bugs Closed Urgent  Export from dwg layer to shape Juan Lucas Domínguez 11/06/2012 02:53 PM

1319 gvSIG bugs Closed Urgent  Export from dwg layer to shape Juan Lucas Domínguez 11/06/2012 02:53 PM

1317 gvSIG bugs Closed Urgent Export from kml layer to shape Juan Lucas Domínguez 11/06/2012 01:38 PM

1317 gvSIG bugs Closed Urgent Export from kml layer to shape Juan Lucas Domínguez 11/06/2012 01:38 PM

1316 gvSIG bugs Closed Low Trying to export gml to shape with out fill the new file name Juan Lucas Domínguez 11/06/2012 02:25 PM

1316 gvSIG bugs Closed Low Trying to export gml to shape with out fill the new file name Juan Lucas Domínguez 11/06/2012 02:25 PM

1315 gvSIG bugs Closed Urgent Export from gml layer to shape Juan Lucas Domínguez 11/06/2012 01:35 PM

1315 gvSIG bugs Closed Urgent Export from gml layer to shape Juan Lucas Domínguez 11/06/2012 01:35 PM

1313 gvSIG bugs Closed Urgent Export from dgn layer to shape Juan Lucas Domínguez 11/06/2012 02:13 PM

1313 gvSIG bugs Closed Urgent Export from dgn layer to shape Juan Lucas Domínguez 11/06/2012 02:13 PM

1302 gvSIG bugs Closed Low 'Group layers' in Toc has not got icon (red square) 04/16/2013 01:38 PM

1302 gvSIG bugs Closed Low 'Group layers' in Toc has not got icon (red square) 04/16/2013 01:38 PM

1294 gvSIG bugs Closed Immediate To edit the symbology of a KML layer corrupts the gvSIG project Juan Lucas Domínguez 11/15/2012 02:14 PM

1294 gvSIG bugs Closed Immediate To edit the symbology of a KML layer corrupts the gvSIG project Juan Lucas Domínguez 11/15/2012 02:14 PM

1278 gvSIG bugs Closed Low Does not possible select windows frome Window menu Juan Lucas Domínguez 11/12/2012 10:01 AM

1278 gvSIG bugs Closed Low Does not possible select windows frome Window menu Juan Lucas Domínguez 11/12/2012 10:01 AM

1274 gvSIG bugs Closed Low Locator_setup "string translation missing" 01/13/2014 02:58 PM

1274 gvSIG bugs Closed Low Locator_setup "string translation missing" 01/13/2014 02:58 PM

1273 gvSIG bugs Closed Low Add_layer 'string translation missing' Juan Lucas Domínguez 11/09/2012 09:57 AM

1273 gvSIG bugs Closed Low Add_layer 'string translation missing' Juan Lucas Domínguez 11/09/2012 09:57 AM

1269 gvSIG bugs Closed Normal  Warning message after try to change the properties of a layer (view) Ignacio Brodín 02/26/2014 12:40 PM

1269 gvSIG bugs Closed Normal  Warning message after try to change the properties of a layer (view) Ignacio Brodín 02/26/2014 12:40 PM

1256 gvSIG bugs Closed Normal No se puede usar el SRC de 8 dígitos/Can't use the 8 digit CRS 01/28/2014 09:11 AM

1256 gvSIG bugs Closed Normal No se puede usar el SRC de 8 dígitos/Can't use the 8 digit CRS 01/28/2014 09:11 AM

1253 gvSIG bugs Closed Low Exporting a layer reprojected on-the-fly does not produce a postgresql layer with the projection of the 
layer reprojected

Juan Lucas Domínguez 01/28/2014 09:12 AM
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1253 gvSIG bugs Closed Low Exporting a layer reprojected on-the-fly does not produce a postgresql layer with the projection of the 

layer reprojected
Juan Lucas Domínguez 01/28/2014 09:12 AM

1252 gvSIG bugs Closed Low Exporting a layer reprojected on-the-fly does not produce a DXF layer with the projection of the layer 
reprojected

01/13/2014 05:07 PM

1252 gvSIG bugs Closed Low Exporting a layer reprojected on-the-fly does not produce a DXF layer with the projection of the layer 
reprojected

01/13/2014 05:07 PM

1226 gvSIG bugs Closed Urgent on the fly reprojection doesn't work for DXF layers Juan Lucas Domínguez 11/08/2012 01:49 PM

1226 gvSIG bugs Closed Urgent on the fly reprojection doesn't work for DXF layers Juan Lucas Domínguez 11/08/2012 01:49 PM

1215 gvSIG bugs Closed Normal Filter tool doesn't work with double fields Juan Lucas Domínguez 11/12/2012 12:29 PM

1215 gvSIG bugs Closed Normal Filter tool doesn't work with double fields Juan Lucas Domínguez 11/12/2012 12:29 PM

1188 gvSIG bugs Closed Urgent On the fly reprojection doesn't work with KML layers Juan Lucas Domínguez 11/09/2012 10:57 AM

1188 gvSIG bugs Closed Urgent On the fly reprojection doesn't work with KML layers Juan Lucas Domínguez 11/09/2012 10:57 AM

1187 gvSIG bugs Closed Urgent On the fly reprojection doesn't work with GML layers Juan Lucas Domínguez 11/09/2012 11:05 AM

1187 gvSIG bugs Closed Urgent On the fly reprojection doesn't work with GML layers Juan Lucas Domínguez 11/09/2012 11:05 AM

1186 gvSIG bugs Closed Normal Wrong layer name in ToC for GML files Juan Lucas Domínguez 11/12/2012 12:45 PM

1186 gvSIG bugs Closed Normal Wrong layer name in ToC for GML files Juan Lucas Domínguez 11/12/2012 12:45 PM

1185 gvSIG bugs Closed Normal Wrong layer name in ToC for KML files Juan Lucas Domínguez 11/12/2012 12:55 PM

1185 gvSIG bugs Closed Normal Wrong layer name in ToC for KML files Juan Lucas Domínguez 11/12/2012 12:55 PM

1183 gvSIG bugs Closed Low View refresh fails after exporting a layer 01/13/2014 03:07 PM

1183 gvSIG bugs Closed Low View refresh fails after exporting a layer 01/13/2014 03:07 PM

1108 gvSIG bugs Closed Low 2 Iconos info by point diferentes Ignacio Brodín 02/01/2014 01:33 PM

1108 gvSIG bugs Closed Low 2 Iconos info by point diferentes Ignacio Brodín 02/01/2014 01:33 PM

1101 gvSIG bugs Closed Normal 'Toolbox' has not got icon (red square) Ignacio Brodín 11/27/2012 01:57 PM

1101 gvSIG bugs Closed Normal 'Toolbox' has not got icon (red square) Ignacio Brodín 11/27/2012 01:57 PM

1093 gvSIG bugs Closed Normal Driver de añadir datos por defecto 10/30/2012 04:54 PM

1093 gvSIG bugs Closed Normal Driver de añadir datos por defecto 10/30/2012 04:54 PM

1084 gvSIG bugs Closed Low Cancel in view properties doesn't work after change the epsg 01/13/2014 05:34 PM

1084 gvSIG bugs Closed Low Cancel in view properties doesn't work after change the epsg 01/13/2014 05:34 PM

1082 gvSIG bugs Closed Low The layer name doesn't appear in the configure locator window Ignacio Brodín 01/29/2014 10:31 AM

1082 gvSIG bugs Closed Low The layer name doesn't appear in the configure locator window Ignacio Brodín 01/29/2014 10:31 AM

1081 gvSIG bugs Closed Normal  '_Query_distance' tool doesn't work after click it, it works the last tool activated Juan Lucas Domínguez 09/06/2012 10:38 AM

1081 gvSIG bugs Closed Normal  '_Query_distance' tool doesn't work after click it, it works the last tool activated Juan Lucas Domínguez 09/06/2012 10:38 AM

1080 gvSIG bugs Closed Normal 'measure area' tool doesn't work after click it, it works the last tool activated Juan Lucas Domínguez 09/06/2012 10:41 AM

1080 gvSIG bugs Closed Normal 'measure area' tool doesn't work after click it, it works the last tool activated Juan Lucas Domínguez 09/06/2012 10:41 AM

1078 gvSIG bugs Closed Low Imagen/icono differente para la herramienta zoom - Different Image/icon in zoom tool 09/24/2012 10:23 AM

1078 gvSIG bugs Closed Low Imagen/icono differente para la herramienta zoom - Different Image/icon in zoom tool 09/24/2012 10:23 AM

1075 gvSIG bugs Closed Low Cancel in choose symbol in layer symbology 01/13/2014 05:41 PM

1075 gvSIG bugs Closed Low Cancel in choose symbol in layer symbology 01/13/2014 05:41 PM

1072 gvSIG bugs Closed Low Enable use spatial index checkbox in layer proprties Ignacio Brodín 03/10/2014 10:35 AM

1072 gvSIG bugs Closed Low Enable use spatial index checkbox in layer proprties Ignacio Brodín 03/10/2014 10:35 AM

1005 gvSIG bugs Closed Normal  'select_all_info' button has not got icon (red square) Juan Lucas Domínguez 10/10/2012 09:26 AM

1005 gvSIG bugs Closed Normal  'select_all_info' button has not got icon (red square) Juan Lucas Domínguez 10/10/2012 09:26 AM

961 gvSIG bugs Closed Low Wrong translation in view properties Juan Lucas Domínguez 02/19/2014 09:59 AM

961 gvSIG bugs Closed Low Wrong translation in view properties Juan Lucas Domínguez 02/19/2014 09:59 AM

889 gvSIG bugs Closed Low Agrupación. No funciona zoom a la capa. 01/13/2014 07:39 PM

889 gvSIG bugs Closed Low Agrupación. No funciona zoom a la capa. 01/13/2014 07:39 PM

888 gvSIG bugs Closed Normal Agrupación. No funciona eliminar capa. Ignacio Brodín 01/29/2014 11:00 AM

888 gvSIG bugs Closed Normal Agrupación. No funciona eliminar capa. Ignacio Brodín 01/29/2014 11:00 AM

887 gvSIG bugs Closed Normal Hiperenlace activo salta error Juan Lucas Domínguez 12/18/2012 12:47 PM

887 gvSIG bugs Closed Normal Hiperenlace activo salta error Juan Lucas Domínguez 12/18/2012 12:47 PM

873 gvSIG bugs Closed High change layer name does not work / no se puede cambiar nombre de capa Juan Lucas Domínguez 11/08/2012 12:53 PM

873 gvSIG bugs Closed High change layer name does not work / no se puede cambiar nombre de capa Juan Lucas Domínguez 11/08/2012 12:53 PM

867 gvSIG bugs Closed Urgent Cut or copy a vector layer Juan Lucas Domínguez 11/07/2012 01:41 PM

867 gvSIG bugs Closed Urgent Cut or copy a vector layer Juan Lucas Domínguez 11/07/2012 01:41 PM

859 gvSIG bugs Closed Normal Exportar capa. Errores por dejar al usuario hacer cosas incorrectas. Juan Lucas Domínguez 12/17/2012 02:20 PM

859 gvSIG bugs Closed Normal Exportar capa. Errores por dejar al usuario hacer cosas incorrectas. Juan Lucas Domínguez 12/17/2012 02:20 PM

852 gvSIG bugs Closed Low Crear nueva capa. Textos en idioma incorrecto. 01/13/2014 07:42 PM

852 gvSIG bugs Closed Low Crear nueva capa. Textos en idioma incorrecto. 01/13/2014 07:42 PM

817 gvSIG bugs Closed Normal The Information tool window should be no-modal Juan Lucas Domínguez 08/21/2012 01:48 PM

817 gvSIG bugs Closed Normal The Information tool window should be no-modal Juan Lucas Domínguez 08/21/2012 01:48 PM

816 gvSIG bugs Closed Normal Information tool only shows geometry info Juan Lucas Domínguez 08/21/2012 01:51 PM

816 gvSIG bugs Closed Normal Information tool only shows geometry info Juan Lucas Domínguez 08/21/2012 01:51 PM

815 gvSIG bugs Closed Normal Little spelling mistake ("pixel" by "Pixel") Juan Lucas Domínguez 11/08/2012 12:50 PM

815 gvSIG bugs Closed Normal Little spelling mistake ("pixel" by "Pixel") Juan Lucas Domínguez 11/08/2012 12:50 PM

813 gvSIG bugs Closed Normal .dgn layer properties. Warning about not supported geom type and then console appears. Juan Lucas Domínguez 08/21/2012 02:11 PM

813 gvSIG bugs Closed Normal .dgn layer properties. Warning about not supported geom type and then console appears. Juan Lucas Domínguez 08/21/2012 02:11 PM

807 gvSIG feature requests Closed Normal Set aleatory as default option for fill color (symbology preferences) Juan Lucas Domínguez 08/22/2012 10:01 AM

807 gvSIG feature requests Closed Normal Set aleatory as default option for fill color (symbology preferences) Juan Lucas Domínguez 08/22/2012 10:01 AM

782 gvSIG feature requests Closed Normal Add a shortcut to the view app preferences from the view properties window Juan Lucas Domínguez 10/11/2012 01:52 PM

782 gvSIG feature requests Closed Normal Add a shortcut to the view app preferences from the view properties window Juan Lucas Domínguez 10/11/2012 01:52 PM

770 gvSIG bugs Closed Normal Can't load a "wrong" shapefile 01/13/2014 01:51 PM

770 gvSIG bugs Closed Normal Can't load a "wrong" shapefile 01/13/2014 01:51 PM

766 gvSIG bugs Closed Normal Add file layer OK button that shouldn't be enabled Juan Lucas Domínguez 08/22/2012 10:06 AM

766 gvSIG bugs Closed Normal Add file layer OK button that shouldn't be enabled Juan Lucas Domínguez 08/22/2012 10:06 AM

764 gvSIG bugs Closed Normal Wrong background color in ToC items Juan Lucas Domínguez 08/22/2012 10:10 AM

764 gvSIG bugs Closed Normal Wrong background color in ToC items Juan Lucas Domínguez 08/22/2012 10:10 AM

749 gvSIG bugs Closed Normal The status bar coordinate box is constantly resizing. Cesar Ordiñana 08/22/2012 10:35 AM

749 gvSIG bugs Closed Normal The status bar coordinate box is constantly resizing. Cesar Ordiñana 08/22/2012 10:35 AM

747 gvSIG feature requests Closed Normal Show the CRS of each layer to be loaded in the add layer window Juan Lucas Domínguez 11/08/2012 12:35 PM

747 gvSIG feature requests Closed Normal Show the CRS of each layer to be loaded in the add layer window Juan Lucas Domínguez 11/08/2012 12:35 PM

725 gvSIG bugs Closed High Can't add two file layer at once. Cesar Ordiñana 07/03/2012 12:26 PM

725 gvSIG bugs Closed High Can't add two file layer at once. Cesar Ordiñana 07/03/2012 12:26 PM

578 gvSIG bugs Closed Normal Wrong numeric scale on status bar Ignacio Brodín 08/22/2012 10:46 AM

578 gvSIG bugs Closed Normal Wrong numeric scale on status bar Ignacio Brodín 08/22/2012 10:46 AM

561 gvSIG bugs Closed Normal Export to from DXF to Shape does not work Juan Lucas Domínguez 07/03/2012 12:38 PM
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561 gvSIG bugs Closed Normal Export to from DXF to Shape does not work Juan Lucas Domínguez 07/03/2012 12:38 PM

528 gvSIG bugs Closed High View properties doesn't adapt well to bigger fonts Cesar Ordiñana 06/13/2012 01:44 PM

528 gvSIG bugs Closed High View properties doesn't adapt well to bigger fonts Cesar Ordiñana 06/13/2012 01:44 PM

525 gvSIG bugs Closed Normal For each new view document two Drawer Worker threads are created and never stopped Cesar Ordiñana 08/29/2012 02:08 PM

525 gvSIG bugs Closed Normal For each new view document two Drawer Worker threads are created and never stopped Cesar Ordiñana 08/29/2012 02:08 PM

510 gvSIG bugs Closed Low Bad performance loading big vector layers (1mill features) Juan Lucas Domínguez 10/16/2012 01:31 PM

510 gvSIG bugs Closed Low Bad performance loading big vector layers (1mill features) Juan Lucas Domínguez 10/16/2012 01:31 PM

500 gvSIG bugs Closed Immediate Error al exportar a SHP Juan Lucas Domínguez 08/21/2012 01:35 PM

500 gvSIG bugs Closed Immediate Error al exportar a SHP Juan Lucas Domínguez 08/21/2012 01:35 PM

393 gvSIG feature requests Closed High Corregir orden de aparición de nuevas capas en el TOC Juan Lucas Domínguez 01/28/2014 09:12 AM

393 gvSIG feature requests Closed High Corregir orden de aparición de nuevas capas en el TOC Juan Lucas Domínguez 01/28/2014 09:12 AM

254 gvSIG bugs Closed High unable to add shapefile with duplicated field name / no abre shp con nombre de campos repetidos Juan Lucas Domínguez 01/27/2014 12:46 PM

254 gvSIG bugs Closed High unable to add shapefile with duplicated field name / no abre shp con nombre de campos repetidos Juan Lucas Domínguez 01/27/2014 12:46 PM

227 gvSIG bugs Closed Normal The temporal filter doesn't work Jorge Piera 02/26/2014 12:35 PM

227 gvSIG bugs Closed Normal The temporal filter doesn't work Jorge Piera 02/26/2014 12:35 PM

224 gvSIG bugs Closed High TOC doesn't adapt well to bigger fonts 06/28/2012 12:34 PM

224 gvSIG bugs Closed High TOC doesn't adapt well to bigger fonts 06/28/2012 12:34 PM

182 gvSIG feature requests Closed High Implement the Shape provider for the newlayer library Jorge Piera 02/26/2014 12:35 PM

182 gvSIG feature requests Closed High Implement the Shape provider for the newlayer library Jorge Piera 02/26/2014 12:35 PM

118 gvSIG feature requests Closed Low Scripting buttons are too big Jorge Piera 12/19/2012 12:26 PM

118 gvSIG feature requests Closed Low Scripting buttons are too big Jorge Piera 12/19/2012 12:26 PM

117 gvSIG feature requests Closed Low Scripting: Remove Composer button Jorge Piera 02/26/2014 12:35 PM

117 gvSIG feature requests Closed Low Scripting: Remove Composer button Jorge Piera 02/26/2014 12:35 PM

112 gvSIG feature requests Closed Urgent Change the name of some flaps within the New Layer wizard Jorge Piera 11/15/2012 01:22 PM

112 gvSIG feature requests Closed Urgent Change the name of some flaps within the New Layer wizard Jorge Piera 11/15/2012 01:22 PM

111 gvSIG feature requests Closed Urgent Reorganize parameters of the New layer wizard Jorge Piera 01/25/2012 12:33 PM

111 gvSIG feature requests Closed Urgent Reorganize parameters of the New layer wizard Jorge Piera 01/25/2012 12:33 PM

110 gvSIG bugs Closed Urgent Fields that shouldn't be enabled when defining a new layer Jorge Piera 11/12/2012 10:12 AM

110 gvSIG bugs Closed Urgent Fields that shouldn't be enabled when defining a new layer Jorge Piera 11/12/2012 10:12 AM

108 gvSIG feature requests Closed Immediate Improve the "Layer-export to..." wizard Cesar Ordiñana 02/26/2014 12:35 PM

108 gvSIG feature requests Closed Immediate Improve the "Layer-export to..." wizard Cesar Ordiñana 02/26/2014 12:35 PM

107 gvSIG feature requests Closed Immediate Improve the "New layer" wizard usability Cesar Ordiñana 12/17/2012 10:59 AM

107 gvSIG feature requests Closed Immediate Improve the "New layer" wizard usability Cesar Ordiñana 12/17/2012 10:59 AM

82 gvSIG feature requests Closed Immediate Improve the usability of the "add layer from file" dialog box Jorge Piera 02/26/2014 12:36 PM

82 gvSIG feature requests Closed Immediate Improve the usability of the "add layer from file" dialog box Jorge Piera 02/26/2014 12:36 PM
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